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1 Introduction

The ADLINK Edge Vision Analytics (EVA) SDK provides an integrated development environment (IDE) for
developers wanting to build computer vision and video analytic solutions with deep learning technology. The EVA
SDK IDE is based on PyFlow, a general purpose runtime extendable Python Qt visual scripting framework, to
expand the EVA SDK. The EVA SDK IDE allows users to quickly establish GStreamer pipelines and easily modify
their properties.

This document introduces the EVA SDK IDE interface including how to generate GStreamer pipelines and how to
get admetadata information from ADLINK GStreamer elements. This document does not include information on
PyFlowBase features. For more details about the PyFlowBase, refer to
https://pyflow.readthedocs.io/en/latest/index.html.

The EVA SDK IDE supports 64-bit Microsoft Windows operating systems. Refer to the EVA SDK Installation Guide
for information on installing any additionally required software.

After installing the EVA SDK and required software, execute the EVA SDK IDE using one of the following methods:

Method 1: Run the desktop shortcut.
From the Windows Desktop, double-click the EVA SDK IDE icon.

B A
IDE

The shortcut will automatically set the environment variables and execute the EVA SDK IDE.

Method 2: Manually run the environment variable settings, and then execute the EVA SDK IDE.

Open a command prompt in Windows and run the following command to set the environment variables.

> C. \ ADLI NK\ gst reaner\ set upvars. bat

> C.\ADLI NK\ eva\ scri pts\setup_eva_envs. bat

Note: The environment variables are removed when the command prompt is closed.

After setting the environment variables, execute the EVA SDK IDE.

> EVA | DE. exe

Introduction 1
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2 EVA SDK IDE User Interface

This chapter introduces the EVA SDK IDE user interface (Ul) and common Ul operations.

2.1 Introduction

This section is a detailed description of the UL.

BB EvA IDE - Untitled* — O *

==M0C00

L

Owning graph:

Inputs

name:

dither:  bayer

dither-guantization: 1

chroma-resampler:  linear Element

alpha-mode:  copy

alpha-value: 1.0

Figure 1: EVA SDK IDE User Interface (Ul)
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Table 1: EVA SDK IDE User Interface (Ul) Items

Item Description

Canvas This area is used to edit elements and pipelines.

Element (Node) The element is the node from PyFlowGstreamer. Only support the configurable
GStreamer element list.

Pipeline Use this area to link the elements as a pipeline.

GStreamer Control Buttons

After creating a pipeline, click “Play”, “Pause” or “Stop” to control it.

» Play: plays a GStreamer pipeline

Ry

-

ill; Pause: pauses a GStreamer pipeline.
-

s

g

(M, Stop: stops a GStreamer pipeline.

S

4

Properties

Select an element to show its editable properties. For more details, refer to Edit
Properties of Elements

Metadata Viewer

Shows the width, height, format of the video stream, the execution time, and Al
information.

For more details, refer to How to Review the Admetadata information.

Alignment Buttons

Select the nodes and click the alignment button to align them.

"i Aligns the selected nodes to the left node.
d Aligns the selected nodes to the right node.
'ET Aligns the selected nodes to the top node.

'Ij_ Aligns the selected nodes to the bottom node.

Canvas Screenshot

[Dﬁ Takes a screenshot of the canvas and saves the image to file. The default image file
* format is PNG.

Click the down arrow to change the image format.

EVA SDK IDE User Interface
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2.2 Ul Operations

22.1 Move the Canvas
Method 1: Hold down <Alt> and the left mouse button to drag the canvas.
Method 2: Hold down the middle mouse button to drag the canvas.

2.2.2 Zoom the Canvas

Method 1: Scroll the mouse wheel to zoom the canvas.
Method 2: Press <Ctrl> + <=> to zoom in the canvas; press <Ctrl> + <->to zoom out the canvas.

Method 3: Hold down the right mouse button and move the mouse to zoom the canvas.

2.2.3 Hotkeys

Quickly zoom in and display a node: Click the node (element) on the canvas and press <F>.

Quickly display all nodes: Press <H>.

EVA SDK IDE User Interface 5
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3 Creating GStreamer Pipelines

This chapter describes how to create and run GStreamer Pipelines in the EVA SDK IDE.

3.1 Adding an Element

3.1.1 Right-click Method

Use the following steps to add an element using the right-click method.

1. Right click on the canvas.

2. Select PyFlowGstreamer and choose the element, or enter element name in enter node name to search
the specified element.

Byl

PyFlow amer
adaifiltertemplate videotestsrc
adbatch
admetadata
adrt
adtrans
advino
il
autodetect
bayer
coreelements

3. Drag the specified element to the canvas.

videote
PyFlowGstreamer
videotestsrc

Creating GStreamer Pipelines 7
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3.1.2 NodeBox Method

Use the following steps to add an element using the NodeBox method.

1. Tools > PyFlowBase - NodeBox

B3 EvA IDE - Untitled

File | Tools

m PyFlowBase >

treamer

: 2 Properties
Metada "
Variables

ModeBox

Search results
Properties

Logger

2. Select PyFlowGstreamer and choose the element, or enter element name in enter node name to search
the specified element.

MNodeBox

PyFlowBase PyFlowGstreamer
PyFlowGstreamer videotestsrc
adaifiltertemplate videotestsrc
adbatch
admetadata
adrt
adtrans
advino
app

3. Drag the specified element to the canvas.

videotestsrc

b

PyFlo
videotestsrc

Creating GStreamer Pipelines
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3.1.3 Pin Hint Method

Use the following steps to add an element using the Pin Hint method.

1. Left-click a source pin of an element (such as src pad or sink pad) and drag it to an empty space.

=000

2. The NodeBox will display on the screen. Enter an element name in enter node name to search the specified
element.

B Pt D - Untitled* - o x

M0 00

Creating GStreamer Pipelines 9
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3.3

Note: Properties must be modified when the pipeline state is stopped.

Deleting Elements

To delete an element, select it and then press <Delete>.

Editing Element Properties

1. Select an element to modify its properties. For example, select videotestsrc to display its properties.

&8 Eva IDE - Untitled™

=M11000

Inputs

name:  vides

blocksize: 4096

num-buffers:

typefind: W

do-timestamp: W

pattern: smpte

timestamp-offset: 0

is-live: W

ko: 0

2. Click pattern, and select ball.

pattern: smpte
smpte

timestam

L

ma

videotestsrc

name
blocksize

num-buffers

typefind

do-timestamp
pattern
timestamp-offset
is-live

ko

ky

kt

bt

kyt

foay

10
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3.4 Linking/Unlinking Elements

3.4.1 Linking Elements

To connect elements, left-click the source’s element GstPin and drag it to the target’s GstPin. GstPin includes src
and sink. In the following example, The left figure is a sink GstPin connected to a src GstPin. The right figure is a
src GstPin connected to a sink GstPin.

videotestsnc o vi deoconvert videotestore

S - — — — Osink name

blocksize name

05 nu

typefind dither typefind dither

e ither-quantizati ; ; izati
do-timestamp dither-quantization do-timestamp dither-quantization

pattern chroma- resampler

pattern chroma-resampler

timestamp-offset Hlpie o timestamp-offset

is-live a alue e
ke
kx
ky

Kkt primaries-mode

ke ct mode

kx mat rix-mode

ky gamma-mode

kt primaries-mode

lot n-threads
n-threads

kyt

The following figure is linked.

videotestsrc - videoconvert

@sink

name

qos
typefind dither
do-timestamp dither-quantization
pattern chroma-resampler
timestamp-offset alpha-mode
is-live
ke

mat rix-mode

gamma-mode

primaries-mode

n-threads

Note: If using pin hints, the connection will link automatically.

If the sink GstPin or src GstPin supports multiple streams, such as a tee element that supports multiple output
streams, multiple elements can be connected.

Creating GStreamer Pipelines 11
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3.4.2 Unlinking Elements
Click the connection near sink or src GstPad to unlink the elements.
3.5 Pipeline Controls

3.5.1 Play a Pipeline

After creating a complete pipeline in the IDE canvas, click the play button (:i) to play the pipeline.

3.5.2 Pause a Pipeline

After creating a complete pipeline in the IDE canvas, click the pause button (211_1;) to pause the pipeline.

3.5.3 Stop a Pipeline

After creating and playing a complete pipeline in the IDE canvas, click the stop button (/\ll) to stop the pipeline.

12 Creating GStreamer Pipelines
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3.6 GstVideoRaw

Use GstVideoRaw to support the capsfilter element to enforce video/x-raw data format, width, height and
framerate.

width: The width of the image in pixels.

height: The height of the image in pixels.

FPS: The video frames per second. Default = 0.
Format: The format of the video.

&8 EvA IDE - Untitled” - m] *

GstVideoRaw

O sink
width
il height
width: 0 = FPS
format

format:

Use limitation

GstVideoRaw’s GstPin can only be linked once. If the connection is removed, GstVideoRaw and the related
element node must be rebuilt by deleting the original node and creating a new one.

The following figure is an example using GstVideoRaw.

Creating GStreamer Pipelines 13
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After unlinking a GstVideoRaw node and videotestsrc element, they cannot be reconnected; they must be deleted.
To reuse videotestsrc or GstVideoRaw, new elements must be created.

videotestsrc i - Gst\ideoRaw

.. @ sink
name

blocksize width
num-buffers

typefind

do-timestamp

pattern

timestamp- offset

3.7 Collapsing/Expanding Element Properties

Click to collapse an element, and to expand it.

videoconvert

do-timestamp

pattern

14 Creating GStreamer Pipelines
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3.8 Use Cases
This section includes examples on how to use the EVA SDK IDE.
3.8.1 Use Case 1

This example describes how to play a test video via OpenGL.

Use the following gst-launch command.

gst-launch-1.0 videotestsrc ! videoconvert ! glinmagesink

First, add a videontestscr element, a videoconvert element, and a glimagesink element to the canvas in the EVA
SDK IDE. The videotestsrc element must connect to the videoconvert element, and the videoconvert element must
connect to the glimagesink element as shown in the figure below.

videotestsrc e videoconvert . glimagesink

i ®sink
name ——————— @sink src@b—ou |

] name
blocksize name

rum-buffers aos async-handling
typefind dither

do-timestamp dither-quantization

message-foruard
sync

pattern chroma-resampler max-lateness

timestamp-offset alpha-mode oS
async

Sts-offset

is-live alpha-value

ko chroma-mode
enable-last-sample

blocksize
render-delay
throttle-time

kex matrix-mode
o ky gamma-mode
kt primaries-mode
foct n-threads
kyt
Iy
fec2
ky2

max-bitrate

contrast

brightnes:s

hue

1kt2 saturation
xoffset rotate-method

yoffset force-aspect-ratio

foreground-color handle-events
background-color ignore-alpha

hord zontal -speed show-preroll-frame
animation-mode output-multiview-mode
motion output-multiview-downmix-mode

flip

Click the play button to show the video in an OpenGL renderer.

B OpenGL renderer - O x

Click the stop button to stop the pipeline.

Creating GStreamer Pipelines 15
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3.8.2 Use Case 2

This example describes how to play a test video with a ball pattern via OpenGL.

gst-launch-1.0 vi deotestsrc pattern=ball

vi deoconvert

gl i magesi nk

Following from the example in Use Case 1, in the stop state, select the videotestsrc element and modify its pattern

property to ball.

B3 Eva IDE - Untitled*

m B oot

videotestsrc
Properties

Base
Name:

Owning graph:

Inputs
name:  vide
blocksize: 4096
num-buffers:
typefind: W

do-timestamp: W

pattern:  ball

timestamp-offset 0

8" OpenGL renderer - O *

Click the stop button to stop the pipeline.

G

16
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3.9 Gst Commands

To generate Gst commands from pipelines in the canvas, click Play GStreamer pipeline. If the pipeline can be
played, gst-lauch-1.0 commands will be generated in C:\ADLINK\eva\IDE\command.txt.

If there is more than one pipeline in the canvas, all of the commands will be included in the file.

In the following example, there are two pipelines in the canvas.

B vt IDF - Untitled® - o S

Elimagesink

typetimd: W

do-timestamp: 1l

pattern  bal

timestamp-offset:  ©

e B

After playing, the gst commands are created in command.txt.

1| command.bét - Notepad - O *
File Edit Format View Help

—————————————————————————— Pipeline No.2-------------oommmmmo o
gst-launch-1.0@ videotestsrc pattern=ball ! videoconvert ! d3dvideosink

Note: The command file will be erased each time GStreamer is played. Be sure to back up command.txt if you
want to save the Gst commands.

Creating GStreamer Pipelines 17
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4 Reviewing Admetadata Information

Admetadata information includes the width, height and format of the video, execution time (ms), and inference
information (if any) in the specified element.

After creating a complete pipeline, click Viewimage, @ or 9 on the specified element to open its metadata
viewer. If there is no video source, the screen will show nolmage.

©. Close state.

% Open state.

videotestsre S videoconvert

nolmage

®:
num-buffers

typefind dither

dither-quan

n-threads

output-multivi ownimd x-mode

motion

flip

Click the play button to start the pipeline; the image (if any) will display. Then click the specified element; the
metadata viewer will show the Admetadata information.

videoconwvert

Image will display

Height: 240
Formakt: RGBA

Exec time(ms): 0.06290131629107402

Click here.

The Admetadata information will display in Medata viewer.

n-threads

After playing and showing the admetadata information, you can click the pause button to pause the streams, or
click the play button to keep playing them.

Reviewing Admetadata Information 19
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5 Save/Load a GStreamer Pipeline

5.1 Save a GStreamer Pipeline
File > Save or File > Save as a pygraph file

Save as

Custorm |3 Custorm O

5.2 Load a GStreamer Pipeline
File = Load to load a pygraph file

Custom [

Note: The EVA SDK IDE cannot load a pygraph file that contains unsupported elements. For example, Windows
does not support ximagesink. If the pygraph file includes ximagesink, the EVA SDK IDE will not load the file
successfully.

Save/Load a GStreamer Pipeline 21
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6 Use Limitations

6.1.1 EVA SDK IDE Limitations

PyFlow’s preferences settings cannot be modified. User’'s modifications will not be retained.

The EVA SDK IDE will not retain the dock tools added by users.

The EVA SDK IDE will not restrict users from mismatched translators to connect the inference models.
Confirm that the inference model elements will connect to the matched translator. Otherwise, the incorrect
translator may try to access memory without permission, causing the EVA SDK IDE to crash. For example,
a Yolo inference model must use the adtrans_yolo element.

6.1.2 PyFlow Known Issues

After clicking “New file”, the pyflowbase node or the gstreamer element cannot add to the
canvas any more. To fix this issue, restart the EVA SDK IDE.
Abnormal mouse operations may make PyFlow crash. To fix this issue, restart the EVA SDK IDE.

6.1.3 GStreamer Pipeline Limitations

There cannot be any unlinked source elements such as filesrc in the canvas.
There cannot be any unlinked sink elements such as autovideosink in the canvas.
There cannot be any unlinked bin elements such as decodebin in the canvas.

6.1.4 glimagesink Element Limitations

The glimagesink element only supports one object in the pipeline on Windows.

Only one glimagesink node can be added to the canvas on Windows.

When adding a GStreamer element to the canvas, a new gstreamer object will be created automatically. If
an existing glimagesink element is deleted from the canvas and a new one is added, there will be multiple
glimagesink objects.

Use Limitations 23
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Safety Instructions

Read and follow all instructions marked on the product and in the documentation before you operate your system.
Retain all safety and operating instructions for future use.

Please read these safety instructions carefully.

Please keep this User‘'s Manual for later reference.

Read the specifications section of this manual for detailed information on the operating environment of this
equipment.

When installing/mounting or uninstalling/removing equipment, turn off the power and unplug any power
cords/cables.

To avoid electrical shock and/or damage to equipment:

Keep equipment away from water or liquid sources.

Keep equipment away from high heat or high humidity.

Keep equipment properly ventilated (do not block or cover ventilation openings).

Make sure to use recommended voltage and power source settings.

Always install and operate equipment near an easily accessible electrical socket-outlet.
Secure the power cord (do not place any object on/over the power cord).

Only install/attach and operate equipment on stable surfaces and/or recommended mountings.

If the equipment will not be used for long periods of time, turn off and unplug the equipment from its
power source.

Never attempt to fix the equipment. Equipment should only be serviced by qualified personnel.

24
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Ask an Expert: http://askanexpert.adlinktech.com

ADLINK Technology, Inc.

Address:

Tel:
Fax:
Email:

9F, No0.166 Jian Yi Road, Zhonghe District
New Taipei City 235, Taiwan
+886-2-8226-5877

+886-2-8226-5717
service@adlinktech.com

Ampro ADLINK Technology, Inc.

Address:
Tel:

Toll Free:
Fax:
Email:

5215 Hellyer Avenue, #110, San Jose, CA 95138, USA
+1-408-360-0200

+1-800-966-5200 (USA only)

+1-408-360-0222

info@adlinktech.com

ADLINK Technology (China) Co., Ltd.

Address:

Tel:
Fax:
Email:

300 Fang Chun Rd., Zhangjiang Hi-Tech Park, Pudong New Area
Shanghai, 201203 China

+86-21-5132-8988

+86-21-5132-3588

market@adlinktech.com

ADLINK Technology GmbH

Address:

Tel:
Fax:
Email:

Hans-Thoma-Strafie 11
D-68163 Mannheim, Germany
+49-621-43214-0

+49-621 43214-30
germany@adlinktech.com

EVA IDE User's Manual|

Please visit the Contact page at www.adlinktech.com for information on how to contact the ADLINK regional office

nearest you.

Getting Service
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